
In this chapter

• Understanding the order in which Excel
performs calculations.

• Entering and editing formulas using the
point-and-click technique. 

• Determining totals quickly with AutoSum.

• Inserting functions to perform complex cal-
culations.

• Troubleshooting calculations in formulas.

• Playing “What If?” with formulas and
functions by experimenting with values.

6

Automating

Calculations with

Formulas and

Functions

Although an Excel worksheet is ideal for arranging entries in columns

and rows, that’s not its main purpose. You can do that with a table in a

word processing application. What makes a worksheet so powerful is

that it can perform calculations using various values from the worksheet

and values you supply. In addition, you can set up unlimited scenarios

for your worksheet that supply different numbers in the calculations,

enabling you to play “What if…?” with various sets of numbers! In this

chapter, you learn how to unleash the power of Excel’s formulas, func-

tions, and other calculation tools.
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Learning the Order of Operations
One of your grade school math teachers probably introduced you to the order of
operations, which governs the order in which a series of mathematical equations is
performed. Excel follows this standard order of operations, as well. In every formula,
Excel performs the equations from left to right in the following order, which gives
some operators precedence over others:

1st All operations in parentheses

2nd Exponential equations or operations

3rd Multiplication and division

4th Addition and subtraction

Keeping precedence in mind is important when you are entering formulas because
the order of operations determines the result. For example, if you wanted to deter-
mine the average of the values in cells A1, B1, and C1, and you entered
=A1+B1+C1/3, Excel would probably generate the wrong answer. Rather than total
the three values and then divide by three, as you might expect, Excel first divides the
value in C1 by three and then adds that result to A1+B1. It calculates this way
because division takes precedence over addition. So, how do you correctly determine
this average? You must enclose in parentheses the operations you want performed
first. In this example, you need to total A1 to C1 first. To do that, enclose the cell
addresses in parentheses: =(A1+B1+C1)/3. This tells Excel to total the values first and
then divide the total by three.

Entering Formulas
As you learned in Chapter 1, “Understanding Excel Worksheets (Spreadsheets),”
every formula begins with an equal sign (=) and can include cell references, mathe-
matical symbols (such as + and –), and actual numbers. You enter a formula in the
cells in which you want the formula’s results displayed. Excel gives you two options
for entering formulas: You can use the point-and-click technique or type formulas.
These techniques are described in the following sections.

Using Point-and-Click Entry
The easiest and most foolproof way to enter a formula is to use the point-and-click
approach. You simply start your formula with an equal sign, click cells to add their
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addresses to the equation, and type the required mathematical sym-
bols. The following instructions lead you step-by-step
through the process:

1. Select the cell in which you want the for-
mula’s result to appear.

2. Type the equal sign (=).

3. Click the cell whose address you want to
appear first in the formula. The cell
address appears in the formula bar.

4. Type a mathematical operator after the
value to indicate the next operation you
want to perform. For example, type + to
add the next entry, – to subtract, * to mul-
tiply, or / to divide by.

5. Continue clicking cells and typing opera-
tors until you finish entering the formula,
as shown in Figure 6.1. (Remember to
group operations using parentheses, if
necessary, to control the order of opera-
tions.)

6. When you finish, press Enter to accept the formula.
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FIGURE 6.1

The easiest way

to compose for-

mulas is to point

and click.

3. Type mathematical operators between cell addresses.

2. Click a cell to insert its address. 1. Start with an equal sign.

If an error message
appears in the cell in
which you typed a for-
mula, make sure you did
not enter a formula that
told Excel to do one of the follow-
ing: divide by 0 or a blank cell, use
a value from a blank cell, delete a
cell being used in a formula, or use
a range name when a single cell
address was expected. For more
details about formula error mes-
sages, see “Troubleshooting Errors
in Formulas,” later in this chapter.

caution
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Typing Formulas Manually
Though point-and-click formula entry is the best
error-free method of constructing formulas, typ-
ing is typically faster. To type a formula, click
the cell in which you want the formula’s result
to appear, and then type the formula, starting
with an equal sign, and press Enter. To use a
value from another cell in your formula, type
the cell’s address. For example, if cell H3 con-
tains your monthly income and you want to
insert your annual income in cell H4, you would
type =H3*12. This formula tells Excel to multiply
the value in cell H3 by 12 and display the result.

Displaying Formulas
When you enter a formula, Excel displays the
result of that formula in the cell. When you’re
checking your worksheet for errors, however, you
may want to view the formulas rather than their
results. In such cases, you can switch to formula-
display mode by pressing Ctrl+` (hold down the Ctrl
key while pressing the grave accent key). Excel not
only displays the formula, but also highlights the
cells referenced in the formula, as shown in Figure
6.2. Press Ctrl+` to switch back to
displaying the results. (For more information on

viewing and troubleshooting formulas, see
“Troubleshooting Errors in Formulas,” later in this
chapter.)
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tip
Name the cells you want

to refer to in your formula.
You can then use the cell
names in your formulas
rather than use cryptic cell

references. For example, if
your worksheet has a cell

named Income that displays your
total income and another cell
named Expenses that contains
your total expenses, you can enter
the formula =Income–Expenses to
determine your net profit. See
“Naming Cell Ranges” in Chapter
4, “Entering and Editing Labels
and Values.”

To view the formula in
a cell when formula-

display mode is off, click the cell
whose formula you want to view.
Excel displays the formula in the
formula bar.
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Editing Formulas
If you make a mistake while entering a formula, backspace over it and enter your
correction as you would with any other cell entry. If you already accepted the entry
(by pressing Enter or clicking the check mark button), take one of the following steps
to edit the entry:

■ Double-click the cell to enter Edit mode, and then edit the formula as you
would edit any entry.

■ Select the cell that contains the formula, click in the formula bar, and edit
the formula as you would edit any entry.

■ Select the cell that contains the formula, press F2, and then edit the formula
right inside the cell.

Copying and Pasting Formulas
You can copy and paste formulas just as easily as you copy and paste data entries.
When you paste a formula, however, Excel adjusts the cell references in the formula
to reflect their new positions in the worksheet. Figure 6.3 illustrates how Excel treats
cell references when you paste a formula. Cell B8 contains the formula
=B4+B5+B6+B7, which determines the total sales revenue for the Northern District. If
you copy that formula to cell C8 (to determine the total sales revenue for the
Southern District), Excel automatically changes the formula to =C4+C5+C6+C7. This
is usually what you want Excel to do when you copy or move formulas.
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FIGURE 6.2

In formula-

display mode,

Excel displays

formulas, rather

than their

results, in cells.

FormulaCells referenced in the formula
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Figure 6.3 shows a formula in which the cell references are relative: Excel changes
the cell addresses relative to the position of the formula. In this example, the for-
mula was moved one cell to the right, so all the addresses in the formula are also
adjusted one cell to the right.

Sometimes, however, you might not want Excel to adjust a cell reference. Say, for
instance, that your worksheet has a formula that includes a reference to a cell that
contains the state sales tax percentage. You want that cell reference to remain
unchanged no matter where you move that formula or paste a copy of it. In such a
case, you can mark the cell address in the formula as an absolute reference to prevent
Excel from changing the address when you copy or move the formula to another
cell. 

To mark a reference as an absolute, press the F4 key immediately after typing the
reference, or move the insertion point inside the cell reference and press F4. When
you press this key, Excel places a dollar sign before the column letter and the row
number, as shown in Figure 6.4. You can type the dollar signs yourself, but letting
Excel do it is usually easier.

You also can mark the column letter or the row number (but not both) as absolute.
Doing so enables the column letter or row number to change when you copy or
move the formula. Keep pressing F4 until you have the desired combination of dol-
lar signs or type the dollar signs in the cell reference.
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Formula copied into cell C8 determines the Southern District’s sales revenue

Formula in cell B8 calculates the Northern District’s total sales revenue

FIGURE 6.3

Excel adjusts

cell references

when you copy

formulas.
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Changing the Recalculation Setting
As you enter formulas, you might notice that Excel immediately performs the calcu-
lation and displays the result. If you change a value in a cell that the formula uses,
Excel instantly recalculates the entire worksheet! If you have a slow computer and a
long worksheet with a lot of formulas, all this recalculating can slow down Excel sig-
nificantly. To prevent Excel from bogging down, you can turn off the Auto
Calculation feature. Here’s what you do:

1. Open the Tools menu and choose Options. The Options dialog box appears.

2. Click the Calculation tab. The Calculation options appear, as shown in
Figure 6.5.

3. Select Manual and click OK. 
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FIGURE 6.4

To prevent a cell

reference in a

formula from

changing, mark

it as an absolute

cell reference.

Sales tax percentageAbsolute cell reference

FIGURE 6.5

You can choose

manual recalcu-

lation to boost

Excel’s perform-

ance.

Manual

From now on, when you want to recalculate the worksheet, press F9.
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Using the Auto Calculate Feature
Few Excel users notice that when they select a range of cells that contain values, the
status bar displays the sum of those values, as shown in Figure 6.6. This feature pro-
vides you with a quick total of any values in the worksheet without your having to
use a calculator.
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Excel displays

the sum of

selected values.

SumStatus bar

Selected cells

Even fewer Excel users realize that they can change the mathematical operation
Excel performs on those values. Right-click the sum to display a context menu of
available operations, as shown in Figure 6.7, and then click the desired operation.

FIGURE 6.7

You can change

the operation

Excel performs

on the values.

2. Click the desired operation

1. Right-click the sum
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Doing Higher Math with Functions
Functions are ready-made formulas you can use to perform a series of operations
using two or more values or a range of values. For example, to determine the sum of
a series of values in cells A5 to G5, you can enter the function =SUM(A5:G5) rather
than =A5+B5+C5+D5+E5+F5+G5. Other functions can perform more complex opera-
tions, such as determining the monthly payment on a loan when you supply the
values for the principal, interest rate, and number of payment periods.

Every function must have the following three elements:

■ The equal sign (=): Indicates that what follows is a formula or function
and not a label, value, or date.

■ The function name: Indicates the type of operation you want Excel to per-
form—for example, SUM. 

■ The argument: Indicates the cell addresses of the values on which the func-
tion acts—for example, A3:F11. The argument is often a range of cells, but it
can be much more complex.

A function can be part of another formula. For example, =SUM(A3:A9)+B43 uses the
SUM function along with the addition operator to add the value in cell B43 to the
total of the values in cells A3 to A9.

Using the AutoSum Tool
One of the tasks you perform most often is totaling a row or column of values. To
simplify the process, Excel provides a tool devoted to determining totals: AutoSum.

To quickly determine the total of a row or column of values, first click an empty
cell to the right of the row or just below the column of values. Then click the
AutoSum button in the Standard toolbar, as shown in Figure 6.8. AutoSum assumes
you want to add the values in the cells to the left of or above the currently selected
cell, so it displays a marching ants box (called a marquee) around those cells. If
AutoSum selects an incorrect range of cells, you can edit the selection by dragging
over the cells whose values you want to total. When the AutoSum formula is correct,
press Enter or click another cell.

If your worksheet has two or more cells that contain subtotals, you also can use
AutoSum to determine the grand total. Click the cell in which you want to insert the
grand total, and then click the AutoSum button. Click the first subtotal, and then
Ctrl+click any additional subtotals you want to include in the grand total. Press
Enter.
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Note that the AutoSum button doubles as a drop-down list. Click the arrow to the
right of the button to access these additional functions:

■ Average totals the values in the selected cells and divides by the number of
values totaled to determine the average value.

■ Count tallies the number of selected cells to determine the number of entries.

■ Max compares all values in the selected cells and displays the highest value.

■ Min compares all values in the selected cells and displays the lowest value.

■ More Functions displays the Insert Function dialog box, which leads you
through the process of selecting a function and constructing the required
argument. See the following section, “Entering Functions with the Insert
Function Dialog Box.”

Entering Functions with the Insert Function Dialog Box
The SUM and AVERAGE functions are fairly easy to enter because their arguments
consist merely of a string of numbers. Some of the other functions, however—such as
the financial function that determines the payment on a loan—contain several val-
ues and require you to enter those values in the proper syntax (order). To type the
function, you must remember its name and know the required syntax, which can be
quite difficult. The Insert Function dialog box can simplify the process greatly. 
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With the click of

a button,

AutoSum deter-

mines the total.

2. Click AutoSum

3. If you want different cells,
drag over the cells that

contain the desired values

4. Click the Enter button

1. Select the cell where you
want the total inserted
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A description of the function appears here

Select a specific function

Type a description of what you want the
function to do, or select a function category

To use the Insert Function dialog box to paste a function into a cell, follow these steps:

1. Select the cell in which you want to insert the function.

2. Open the Insert menu and select Function, or click the arrow to the
right of the AutoSum button and click More Functions, or click the fx but-
ton in the formula bar. The Insert Function dialog box appears, as shown in
Figure 6.9, displaying a list of available functions.

CHAPTER 6 AUTOMATING CALCULATIONS WITH FORMULAS 
AND FUNCTIONS

117

FIGURE 6.9

The Insert

Function dialog

box enables you

to select the

function rather

than type it.

3. Perform one of the following steps:

In the Search for a Function box, type a description of what you want the
function to do, and then click the Go button or press Enter.

Open the Or Select a Category list and
select the type of function you want to insert. If
you’re not sure, select All to display the
names of all the functions; they are listed
alphabetically.

4. Select the function you want to insert from
the Select a Function list, and click OK.
The Function Arguments dialog box
appears, as shown in Figure 6.10, prompt-
ing you to type the argument. You can type
values or cell addresses in the various text
boxes. Alternatively, you can click the but-
ton to the right of the text box and then
click the cell that contains the specified
value.

When you select a
function in the Select a

Function list, Excel displays a
description of the function. Read
this description to learn the pur-
pose of the function.
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5. Enter the values or cell ranges for the argument. You can
type a value or an argument, or click the cells that con-
tain the required values. (Some arguments,
such as those that start with “If,” are
optional. Excel must “decide” which
action to perform based on entries in
your worksheet.)

6. Click OK or press Enter. Excel inserts
the function and argument in the
selected cell and displays the result.

When you need to edit a function, select the
cell that contains the function you want to
edit. (Make sure you’re not in Edit mode; that
is, the insertion point should not appear in the
cell. If the insertion point appears in the cell,
click a different cell, and then click this cell
again.) Open the Insert menu and select
Function, or click the Insert Function
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1. Click one of these buttons
to hide the dialog box

2. Click the cell that
contains the specified value

If you click a button for
one of the items in the
Function Arguments
dialog box, Excel tucks
the dialog box out of the
way, displaying the address of the
currently selected cell and a button
for bringing the dialog box back
into view. After you select the
desired cell, click the button to the
right of the cell address to redisplay
the dialog box.

caution
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button. This displays the Function Arguments dialog box, which helps you edit your
argument.

Seeing a Loan Function in Action
To get some hands-on experience with functions, let’s take a look at the PMT (pay-
ment) function. This function determines the monthly payment on a loan based on
the loan amount, rate, and payment periods. Here’s how the function and its argu-
ments appear:

=PMT(rate,nper,pv,fv,type)

Let’s break this down:

= is an essential element in the function statement, as explained earlier.

PMT is the function name, which stands for “payment.”

rate is the percentage rate of the loan per period. In other words, if you
take out a 30-year mortgage at 6.5% and plan to make payments every
month, the rate is 6.5%/12 or .541666%. 

nper is the number of payment periods. For example, on a 30-year mort-
gage, 12 payments are due per year, so the total number of payment peri-
ods would be 360.

pv, which stands for “present value,” is the total amount you plan to bor-
row. This amount must be entered as a negative value. For example, if
you’re taking out a $120,000 loan, you would enter -120000.

fv, which stands for “future value,” is zero—that is, the amount the loan
will be worth after you pay the last payment.

type specifies the day in the payment period on which you are required to
submit the payment—0 (or omit the type entry) for the last day of the pay-
ment period or 1 for the first day.

You can type a function using values in place of the codes. For example, to deter-
mine the payment on a $120,000, 30-year loan, at 6.5%, you could type the 
following:

=PMT(.065/12,360,-120000,0,0)

Or, you could use cell references in place of the values. Figure 6.11 shows a sample
worksheet used to determine the monthly mortgage payment on a personal loan.
Note that each value in the typed example is in a separate cell, and that the func-
tion uses cell references in place of actual values.
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Troubleshooting Errors in Formulas
When you enter a formula or function correctly, the cell that contains the formula
or function displays the correct result of the equation. If the result is incorrect or the
cell displays one of the error messages described in Table 6.1, the formula or func-
tion has a problem.

TABLE 6.1 Formula and Function Error Messages
Error Message Indicates

##### Cell is too narrow to display the result.

#VALUE! The wrong type of function, argument, or operand is in use.

#DIV/0! The formula or function calls on Excel to divide a value by zero. In math,
you are never allowed to divide a number by zero.

#NAME? Excel does not recognize a cell reference or other text in the formula or
function. Usually caused by a typo.

#N/A A particular value inside the formula or function is unavailable to it.

#REF! The formula or function contains an invalid cell reference.

#NUM! A numerical value inside the formula or function is invalid.

#NULL! The formula or function references an intersection of two ranges that do
not intersect. Usually indicates that the formula has a space between two
cell references instead of an operator or comma.

In many cases, you can spot the cause of the problem by taking a quick glance at
the formula or function. You may have mistyped an operator or cell reference or
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selected the wrong cell. To spot errors in more complex formulas and functions, how-
ever, you might need help. Fortunately, Excel features three of its very own worksheet
auditors that can help you track down the causes of most errors. Following is a list of
the worksheet auditors with a brief description of each:

■ Trace Precedents highlights the cells that supply values to the formulas, as
shown in Figure 6.12. You can then verify the cell references in the formula
and check to make sure the cells contain the correct values.
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FIGURE 6.12

Trace Precedents

highlights the

cells that supply

values to the for-

mula.

Formula

Cells referenced in formula

■ Trace Dependents highlights cells containing formulas that reference the
currently selected cell. 

■ Trace Error highlights any likely causes of a particular error message that
appears in a cell that contains a formula or function. Trace Error checks for
syntax errors, wrong operands (mathematical symbols), and other possible
causes.

To run any one of these worksheet auditors, follow these steps:

1. Click the cell that contains the function or formula that is not working prop-
erly (or the cell that is referenced by a problem formula or function). 

2. Open the Tools menu, point to Formula Auditing, and select the desired
auditing tool: Trace Precedents, Trace Dependents, or Trace Error. The
auditing tool displays arrows that point to the referenced cells or highlights
errors. Figure 6.13 shows a worksheet analyzed by Trace Error.
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4. Examine the contents of the cells that supply values to the formula, and
examine the formula for any faulty cell references, wrong mathematical
operators, and typos.

5. To remove the auditor’s highlighting and arrows, open the Tools menu,
point to Formula Auditing, and click Remove All Arrows.

Playing “What If?” with Scenarios
Say you’re purchasing a home and need some idea of how much your monthly
mortgage payment is going to be for various loan amounts. You have successfully
created a worksheet that determines the monthly payment for a $120,000 house at
6.5%, but you want to know what the payment would be for a $110,000, a
$130,000, and a $140,000 home. You also want to see the effects of other loan rates.
You could create a bunch of separate worksheets, but a better solution is to create
several scenarios for the same worksheet. A scenario is simply a set of values you
plug into variables in the worksheet.

Excel offers a tool that enables you to plug various sets of values into your formulas
to determine the effects of different values on the outcome. The following sections
show you how to create and manage your own scenarios.

Naming and Saving Different Scenarios
Making a scenario is fairly simple. You name the scenario, tell Excel which cells
have the values you want to play with, and then type the replacement values you
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want Excel to use for the scenario. The following step-by-step instructions walk you
through the process:

1. Display the worksheet for which you want to create a scenario.

2. Open the Tools menu and choose Scenarios. The Scenario Manager
appears, indicating that this worksheet has no current scenarios.

3. Click the Add button. The Add Scenario dialog box appears.

4. Type a name for the scenario that describes the specific changes you’re going
to make. For example, if you were creating this scenario to determine pay-
ments for a $130,000 house at 6.75%, you might type 130K @ 6.75%.

5. Click the Changing Cells text box, and click the cell that contains the value
you want to change in your scenario, as shown in Figure 6.14. To change val-
ues in other cells, hold down the Ctrl key and click them. (When you do,
Excel inserts the addresses of the changing cells as absolute references, sepa-
rating them with commas.)
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6. Click OK. The Scenario Values dialog box displays the current values in the
cells you want to change.

7. Type the values you want to use for this scenario, as shown in Figure 6.15,
and click OK. The Scenario Manager displays the name of the new scenario.

8. To view a scenario, click its name and click the Show button. Excel replaces
the values in the changing cells with the values you entered for the scenario.
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Viewing the Results of Different Scenarios
Whenever you want to play with the various scenarios you’ve created, open the
Tools menu and choose Scenarios. When you choose this option, Excel displays
the Scenario Manager, introduced in the preceding section. The Scenario Manager
offers the following buttons for managing and displaying your scenarios:

■ Show: Displays the results of the selected scenario right inside the worksheet.

■ Add: Enables you to add another scenario.

■ Delete: Removes the selected scenario.

■ Edit: Enables you to select different cells 
used for the scenario and insert 
different values for the variables.

■ Merge: Takes scenarios from various 
worksheets and places them on a single
worksheet.

■ Summary: Displays the results of the var-
ious worksheets on a single worksheet, as
explained in the next section, “Creating a
Summary Report.” 

To play “What if?” with various scenarios, follow
these steps to shift from one scenario to another:

1. Open the Tools menu and choose
Scenarios. The Scenario Manager
appears.

2. Click the name of the scenario you want
to view.
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3. Click the Show button. Excel replaces the values in the changing cells with
the values from the scenario and shows the results. See Figure 6.16.

4. Repeat Steps 2 and 3 for any other scenarios you want to view.

5. When you’re finished examining scenarios, click the Close button.
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Creating a Summary Report
Flipping through scenarios is an excellent way to see how the various scenarios
affect the bottom line, but for a more thorough approach, consider creating a sce-
nario report. A scenario report is a new, separate worksheet that displays the results of
all your scenarios on a single page. And best of all, scenario reports are easy to cre-
ate. Take the following steps:

1. Open the workbook that contains the desired scenarios.

2. Open the Tools menu and choose Scenarios. The Scenario Manager
appears.

3. Click the Summary button. The Scenario Summary dialog box appears,
prompting you to choose a report type and specify the cell in which the result
appears.

4. Make sure Scenario Summary is selected and that the cell in which the sce-
nario’s result is displayed is selected.

5. Click OK. Excel creates a scenario report and displays a new worksheet tab
for it, called Scenario Summary, as shown in Figure 6.17.

6. When you’re finished with the report, simply click the tab for a different
worksheet.
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To get rid of the scenario report altogether, right-click the Scenario Summary tab
and select Delete.
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FIGURE 6.17

The Scenario

Summary

Report displays

the results for

all your scenar-

ios on a single

worksheet.

The Absolute Minimum
The most powerful features of any worksheet are the formulas and functions it con-
tains. You can now create custom accounting sheets, complete with their very own
built-in calculators. Specifically, you learned how to

Control the order in which Excel carries out its mathematical operations.

Enter formulas by typing them or using the point-and-click technique.

Copy and paste formulas and control cell references in formulas by mark-
ing them as absolute or relative.

Insert functions for performing more complex mathematical operations.

Track down the cause of many of the most common formula errors.

Play “What if?” by creating scenarios that substitute one set of key values
for another set of key values in a worksheet.

With the skills you acquired in this chapter, you can create a dynamic worksheet
capable of computing accurate results in a matter of seconds. In addition, you can
safely experiment with other values without affecting the condition of your original
worksheet. Now that you have a working worksheet, it’s time to move on to the next
part, “Formatting, Charting, and Printing Your Worksheet.” 

09 0789729415  CH06  8/12/03  10:18 AM  Page 126


